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Getting Started with SPARQL Rules (SPIN)

SPARQL Rules are a collection of RDF vocabularies such as the SPARQL Inferencing Notation (SPIN) that build on
the W3C SPARQL standard to let you define new functions, stored procedures, constraint checking, and inferencing
rules for your Semantic Web models, all stored using object-oriented conventions and the RDF and SPARQL
standards. TopBraid Composer makes it easy to define SPARQL Rules business logic around your data models by
clicking, dragging, and filling out dialog boxes, and TopQuadrant's TopSPIN engine implements these business rules
so that your applications can use and control their data with many more possibilities than a simple SPARQL engine
can offer.

Using SPARQL Rules, your applications can:

» Calculatethevalue of a property based on other properties—for example, the area of a geometric figureasa
product of its height and width, the age of a person as a difference between today's date and person's birthday, or a
display name as a concatenation of the first and last names.

e Check constraintsand perform data validation—for example, your application can raise inconsistency flags
when currently available information does not fit the specified integrity constraints.

* |solate a set of rulesto be executed under certain conditions—for example, to support incremental reasoning,
to initialize certain values when aresourceisfirst created, or to drive interactive applications.

The SPARQL Rules framework has three layers:

1. An RDF vocabulary for SPARQL A SPARQL Rulesimplementation stores SPARQL queries as RDF triples,
like any other data or metadatain a Semantic Web model. TopBraid Composer lets you view and edit your
SELECT, CONSTRUCT, and other SPARQL queries using the same syntax defined in the W3C's SPARQL
Query Language for RDF Recommendation, but storing them as triples makes it possible to link the queriesto
specific classes, to add metadata about them, and to re-use them in different places. (Y ou can convert between the
W3C syntax and the triples version at the SPIN RDF Converter web site, but when using TopBraid Composer,
these conversions are all automated for you, so there is no need to ever view the triples version of your queries.)

2. SPIN Vocabulary Thisvocabulary includes terms such asspi n: const rai nt and spi n: const r uct or , which
let you define business rules and attach them to classes.

3. ModuleLibrary Thelibrary holds frequently needed modeling patterns, with functions and templates to constrain
cardinalities and value ranges. SPARQL Rules |et you define and store your own re-usable query templates; it also
provides several predefined ones based on modeling patterns that are common in real-world applications.

In thistutorial, you'll begin with a small set of RDF data and do the following with it:

o Cadl built-in extension functions and write, save, and call your own new functions.

« Defineinferencing rules that automatically create |SO 8601 "yyyy-mm-dd" formatted dates from date strings
formatted as "mm/dd/yy" and attach these rules to the Purchase class, where the MaterialsPurchase and
ServiceContract classes can inherit them.

» Define query templates to be called from different rule definitions, making code more modular and reducing
redundancy.

« Automate the addition of a postingDate value to each purchase asit is added to the system.

» Define constraints that alert the user to unpaid materials purchase invoices that are more than 90 days old and
service contract invoices that are more than 60 days old.

Y ou can use this tutorial with any version of TopBraid Composer, including the Free Edition. (It does demonstrate
one extra feature of the Standard and Maestro editions, but this feature is not necessary for the completion of the
tutorial.) It assumes basic familiarity with the use of TopBraid Composer.
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1.1 Conventions

Class, property and individual names are written in a sans serif font like this.

Names for user interface widgets and menu options are presented in a style like this.

Where exercises require information to be typed into TBC amonospaced fontisused | i ke thi s.
Exercises and required tutorial steps are presented like this:

1. Executethefirst step.
2. Then, execute the second step.
3. Hereisthethird step to carry out.

‘{@'

Tips and suggestions for using TBC and building ontologies are presented like this.
Potential pitfalls and warnings are presented like this.

General notes are presented like this.

1.2 The data

Let's start by creating afile that imports the data we'll be working with and taking alook at it.

1. From the File menu, pick New and RDF/OWL file. Giveit abase URI of htt p: / / t opbr ai d. or g/
my Pur chases and filename of myPur chases.

2. Onyour new file's imports view, click the "Import from URL" icon (with the plus sign in front of a globe) and
enter http://topbraid. org/ exanpl es/ pur chases astheresource to import. Save your file.

3. Inthe Classes view, expand the owl: Thing and then Purchase nodes, and you'll see that Purchase has two
subclasses named Material sSPurchase and ServiceContract.

4. Click the yellowish-brown circle next to either one, and in the Instances view you'll see two instances for each.

All the instances have asimilar structure and different data, except that the purchasel02 ServiceContract includes an
additional pai dDat e property. If you click on pai dDat e in the Properties view, you'll see on the Property Form that
it hasanr df s: r ange of "xsd:date", while the dat e property has no rdfs:range assigned, so that its content will be
treated as simple text strings.

If the Property Form is not showing in the main editor window, select the "Form" tab at the bottom of
that window.
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[a] myPurchases.n3 2 = O || Ta properties &3 e~ 0O
Property Form = | S(EE
p ty | =) Bl amount
URL: |http://topbraid.org/examples/purchases =paidDate M date
b owl:versionInfo
) rdfs:comment
~ Property Axioms rdfs:label
dfs:domain — [+ rdfs:seehlso
rifsrange ~
xsd:date -
e
= Other Properties
dfitype =
@ |owl:DatatypeProperty ==
Form | Graph | Source Code B | \J;'

We're going to write a new function that calls a built-in function to convert dat e values to the xsd:date 1SO 8601
yyyy-mm-dd format, but first let's take alook at some of the built-in functions that are available and how we can try
them out.

1.3 Calling built-in functions

The"TopBraid SPARQLMotion Functions Library" page of TopBraid Composer's online help lists over 70 functions
available for you to call from your applications, including string functions, mathematical functions, logical functions,
and ontology functions. Because TopBraid Composer uses the Jena SPARQL engine, it supportsthe LET keyword
for assignment of variables, which gives you away to experiment with built-in variables using a short, simple
SPARQL query.

For example, to try the mathematical function snf : r andon() (aTopBraid Composer extension to the Jena function
library), enter the following query in the SPARQL view's Query Editor tab:

SELECT ?x
VHERE {

LET (?x := snf:randon()).
}

To execute it, either click the "Execute SPARQL" green triangle button & or press Ctrl+Enter, and you'll see arandom
number between 0 and 1 appear in the [x] column of the SPARQL query result. Because this function returns a
different value each time you call it, go ahead and execute it afew more times.

|21 Problems @ Instances | B Rules |l Domain | B8 Relevant Prope SPARQL £ @ Imports = =
PO muEHEER Y

Query Editor | Query Library [x]

SELECT 7x ‘-.. 0.918995154431393%e0

WHERE {
LET {?x := smfirandom{}).

Another built-in extension function issnf : par seDat e() , which converts astring in a semi-structured date format
into an xsd:date, xsd:dateTime, or xsd:time value. (To learn more about snf : r andon() , snf : par seDat e() , and
other available functions, select Help Contents from the Help menu and then TopBraid Composer -> Reference ->
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SPARQLMotion Functions Reference.) This function takes two parameters: a date string and a template showing which
pieces of the date are where in that string. Try pasting the following query into the SPARQL view and executing it:

SELECT ?x
VHERE {
LET (?x := snf:parseDate("12/3/09"," MV dd/yy")).

}
The value displayed under [x] is"2009-12-03".

The TopBraid Composer online help for this function includes the URL of aweb page with greater
detail about options for the format string in the snf : par seDat e() function's second parameter.

We're going to use this function to define a simpler function that converts the Purchase date strings for us.

1.4 Defining your own functions

Before we use the SPARQL Rules vocabulary, we need to import it into our vocabulary. Open your imports view and
drag thespi n. r df filefrom the TopBraid/SPIN folder in the Navigator view into the Import view. You'll see severa
new nodes appear in the Properties view, each with an sp: or spin: prefix and a plus sign next to it that expands the
node to show the full range of SPARQL Rules properties. For this tutorial, you won't need to use these properties
from this view, because TopBraid Composer gives you formsto fill out to specify the functions, rules, and constraints
that you'll create.

When creating a brand new model that will use the SPARQL Rules vocabulary, instead of picking
k RDF/OWL File from the File -> New menu, pick RDF/OWL/SPIN File to create an empty new file with the
SPARQL Rules vocabulary already imported.

The Classes view aso shows afew new classes. Click the plus sign next to spin:Modules to expand it, and you'll see
that one of the subclasses is spin:Functions. (We'll use the other subclass, spin:Templates, later on in thistutorial.)

To create your new function,

1. Right-click on spin:Functions and pick Create subclass from the context menu.

2. Onthe Create Classes dialog box, click on the default new function name of "Functions_1", replace it with the
name "mmddyy2| SO8601", and press Enter.

3. Click the ok button. You'll see that your new subclass of spin:Functionsis currently selected in the Classes view,
and the class form will have the URI and rdfs:subClassOf values aready filled out.
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e

Y our new function will have an argument passed to it: the date string to convert. The body of the function must
reference this argument, so let's define the argument before creating the function body. Like everything elsein
SPARQL Rules, this definition will ultimately be stored with a series of triples, but because argument definition is so
common in application development, TopBraid Composer includes a template to make it easier.

1. SPARQL Rules model arguments to functions as constraints on those functions. On the mmddyy21 SO8601 class
form, click the spin:constraint widget (the small white triangle to the right of the name "spin:constraint") and pick
"Create from SPIN template".

2. Select spl:Argument from the Available Ask/Construct Templates list, and then fill in the following two fields in the
Arguments panel on theright of the Create from SPIN template... dialog box:

* Inthecomment field, enter Convert mi dd/yy formatted date to xsd:date type and fornat.

Remember to press the Enter key after entering avalue on one of these forms. If you tab to
another field and the comment field has a heavier border around it and and the Create from
SPIN template dialog box's ok button is grayed out so that you can't click it, go back to the
comment field and press the Enter key.

« Instead of typing avalue directly into the predicate field, click the plus sign to the right of it. This displays
a Select Resour ce... dialog box; because we're defining our first (and only) argument to pass to the new
mmddyy2l SO8601 function, click sp:arg1 on the right panel and then the ok button.

‘(ﬂ As an alternative to picking Create from SPIN template and clicking the plus sign to point to the

. sp: ar g1 property, you could also have simply dragged sp:arg1 from the Properties view onto the
spin:constraint property name on the form to display the same dialog box with the predicate aready
filled out for you. (You'll till want tofill out the comment field, though.)
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1.5

3. Click the ok button to finish with the Create from SPIN template dialog box, and you'll see that the
spin:constraint field of the class form for your new mmddyy2l SO8601 function has been filled out.

4. All that remainsisto define the function body. Click the spin:body widget on the class form and select Add empty
row.

5. Enter the following as the body:

SELECT ?x
VWHERE {

LET (?x := snf:parseDate(?argl, "MV dd/yy"))
}

The body of this function uses ?x as the variable name, but you can use any name you want. If you
have more than one variable, and it binds to more than one value, the function will return the first value
of thefirst variable, so there's no point in naming more than one variable after the SELECT keyword.

As before, don't forget to press Enter while the cursor is still in the spin:body field to tell the form that
you're finished entering this value. Y ou can also click the ok button to the right of the field.

Note how, in this SPARQL query, the first argument to the snf : par seDat e() functionisar g1, which we defined
on the spin:constraint part of the form earlier.

Y our new functions should be all ready. Test it by entering and executing the following in the SPARQL view:

SELECT ?x
VHERE {
LET (?x := :mddyy2l SO8601("9/6/09")).

}

When you make calls to your own functions, don't forget the colon at the beginning of the function

call and, if your function was not defined in the default namespace, the namespace prefix before that.
All function calls are in a particular namespace (for example, par seDat e() isin the namespace
represented by the snf prefix), and your new mrddyy21 SG8601() function isin the default namespace
for this project. For production application development, it's better to identify the function’'s namespace
with a specific prefix, because it will be easier to import the code into another file without confusion.

mrddyy 21 S08601() isnow afunction that you can call anywhere, including from the body of new functions that
you create. Test it further in the SPARQL view by passing other dates as a parameter.

Thiswas avery simple function. There's alot more you can do when defining your own functions, especially
when you use the SPINx extensions, which let you write functions in JavaScript and call them from subclasses of
spi n: Functi ons likethe muddyy21 SO8601() function that you just created.

Inferencing

In a Semantic Web application, inferencing is the ability to create new information (that is, to generate new triples)
based on information in existing triples. The incremental inferencing feature of the Standard and Maestro editions of
TopBraid Composer makes it possible to derive new triples as data is edited, based on rules about what inferences to
draw.

For our application, we want TopSPIN to check for invoices that are more than 90 days old, but we first must convert
the dates stored with each purchase into aformat that's easier for a computer to work with. We've already written a
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function to do the conversion, but how do we tell the system to apply our nmddyy2l SC8601() function to the dat e
property of each purchase? With inferencing. We will tell TopSPIN that whenever it sees atriple with a predicate of
purchases.date, it should create a new triple with the same subject as the first triple and a predicate of :invoiceDate.
The new triple's object will be the result of passing the original date value to the mmddyy 21 S08601() function.

First we need to declare our new i nvoi ceDat e property:

1. Click the Create property icon on the Properties view = :

2. Inthe Available types section of the Create property... dialog box, select owl:DatatypeProperty, because our new
property will not have an object resource asits value.

3. Inthe Name of new instance field, enter i nvoi ceDat e.

Available types:

=@ rdf:Property
¥ owl:AnnotationProperty
® nl:DatatypeProperty
eprecatedProperty
< wl:FunctionalProperty
@ owl:ObjectProperty

M
| Mame of new instance: | invoiceDate
Annotations Template | 1]
Property Initial Value
rdfs:label

4, Click the ok button.

5. Thei nvoi ceDat evalues are not going to be just arbitrary strings, but dates of type xsd:date. Click the rdfs:range
widget and select "Set to xsd:date".

Rules are attached to classes. We want our new inference rule to work for both the Material sPurchase and the
ServiceContract classes, so we'll attach it to their parent class. Purchase.

The SPARQL Rules storage of all of these rules, constraints, and other kinds of stored procedures as
triples under the covers are what makes it possible to connect them to specific classes and to therefore
take an object-oriented approach to how they are organized and how they affect the data that you want
them to affect.)

1. Intheclasses view, click the yellowish-brown circle next to purchases:Purchase to display its class form. (If you
don't see purchases:Purchase, expand the owl: Thing node.)

2. Weregoing to add a SPARQL CONSTRUCT statement in the spin:rule field to create our new triple, but first
we'll test our CONSTRUCT statement as aregular SPARQL query. Enter the following in the SPARQL view and
execute it:
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CONSTRUCT {?s :invoiceDate ?idate }

VWHERE {

?s purchases: date ?date .

LET (?idate := : mddyy2l SO8601( ?date))
}

Y ou should see the new triples displayed on the right panel of the SPARQL view.

3. Onceyou're sure that this CONSTRUCT statement creates the triples that you want, click the spin:rule widget
on the Purchase class's class form and select Add empty row. Paste the CONSTRUCT statement above over the
default text in that field, which you'll notice has a similar structure to what you're pasting over it.

4. You'renot quite finished defining the rule. Replace the ?s variable on the first and third lines of the
CONSTRUCT statement with ?t hi s, a special variable that refers to the current instance of this classthat is being
being evaluated by the inference rule.

The 2t hi s variable is similar to the variable used in the for-each loop of many programming
languages as they iterate through a collection performing the same steps on each member of the
collection.

Asyou add each 2t hi s variable, TopBraid Composer bolds them in the editor, because it knows that they're
special variables.

5. After fixing the two instances of this variable, press Enter or click ok to the right of the spin:rule field and you're
finished entering the inference rule.

If you're using the Free edition of TopBraid Composer, you're all ready to run your inferencing. If you're using the
Standard or Maestro editions, you many not be ready just yet, because you have several options for configuring what
inference engine or engines do this work and how they go about it. To double-check that your copy of the Standard or
Maestro edition is ready to run the inferencing that you've defined, select Configure Inferencing... from the Inferences
menu and click the File Settings tab. It should be set up to use TopSPIN as the only inferencing engine and to do
incremental inferencing, with the Customize settings for "myPurchases" checkbox checked, as shown here:

& Configure Inferencing...

Project Settings | Waorkspace Settings

[¥] Customize settings for "myPurchases.n3”

Available Inference Engines Selected Inference Engines
| 12na built-n Reasaner | RDF
Pellet 1.5.2 o
SWRL and Jena Rules
SWiftOWLIM | Input: Asserted Triples |
TopSPIM (SPARGL Rules) \l,

{incremental, iteratively)

1

| Output: Inferred Triples |

‘ TopSEIN (SPARGL Rules) ‘

] complete Mode: Do not filter redundant inferences

Close
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If not,
1. Click the Customize settings for "myPurchases" checkbox.

2. Delete any extrainferencing engines from the workflow on the right by selecting them and clicking the x
("Delete") icon above them. If TopSPIN (SPARQL Rules) is not included, select it from the Available Inference
Engines panel on the right and click the Add >> button in the middle.

3. When you have TopSPIN in the workflow on the right, if it says "non-incremental”, double-click it and check the
Incremental inferencing at edit time checkbox on the Configure TopSPIN dialog box.

4. Click the ok button and then the Close button on the Configure I nferencing... dialog box.
Now, regardless of which edition you're using, you're ready to tell TopSPIN to go ahead and do the inferencing you

asked for. Select Run Inferences from the Inference menu button. TopBraid Composer will display new tripletsin the
Inferences View.

L: Problems | 4 Instances | B Relevant Pr SPARGL qf)Impor's & Inferences £3 .

S
[Subject] Predicate Object
‘Epurchaselﬂl Bl invoiceDate e 2003-05-03
@ purchase 102 Bl invoiceDate [z 2009-05-08
@ purchase 103 Bl invoiceDate B 2000-07-19
® purchase 104 Bl invoiceDate & 20000805

When you ran atest CONSTRUCT statement earlier, TopBraid Composer displayed the constructed triplesin the
SPARQL view's results window. Thistime, though, TopBraid Composer added the inferred triples to the data you're
working with. To seethis:

1. Select purchases:MaterialsPurchase OF purchases:ServiceContract from under the purchases:Purchase node in the
Classes view.

2. Activate the Instances view and click the purple diamond next to any of the instances there to display its dataon
the Resource Form. Y ou'll seethat the new i nvoi ceDat e property has been added to it with avalue calculated
according to your inference rule.

(l To recalculate inferred values using the Free edition of TopBraid Composer, select Reset Inferences
k from the Inference menu to remove inferenced values and then Run Inferences again.

The muddyy2I SO8601() function that you created and the CONSTRUCT statement that called it were
actually quite simple. With the other built-in functions available to you, the ability to define and call
your own functions, and the ability to create much more complex CONSTRUCT statements, TopSPIN
inferencing can do far more with your data.

Y ou attached your inferencing rule to the Pur chase class, and because

pur chases: Mat eri al sPur chase and pur chases: Ser vi ceCont ract are subclasses of that,
TopSPIN knew to perform thisinferencing on individuals in those classes—in other words, they
inherited this rule. In alarger, more complex system, this ability to define different inferencing rules for
different classes (and, if necessary during the design process, to move them from one classto amore
appropriate one) lets you organize your rules and their relationships to your datain a structured, well-
organized way.
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1.6 Adding a constructor

Wed also like to record the date and time that each set of purchase data was added to our database, and we can
automate this so that no data entry is required.

1. First, weneed apost i ngDat e property of type xsd:date to store this data. Instead of creating it from scratch,
right-click paidDate Or invoiceDate in the Properties view and select Create clone. Right-click the new property,
pick Rename, and call it post i ngDat e.

2. Onthe Purchase class form, select Add empty row from the spin:constructor widget and paste the following in,
replacing the default skeleton for a CONSTRUCT statement in the spin:constructor field:

CONSTRUCT {
?this :postingDate ?date .

{/\HERE{
LET (?date := afn:now())
}

It's pretty simple, calling the af n: now extension function get the current date and time and then using that
value as the object of atriple about the posting date. Like the CONSTRUCT statement that we used to infer
thei nvoi ceDat e value, thisalso uses the special variable name 2t hi s to refer to the Purchase instance being
evaluated.

3. PressReturn or click ok and your simple constructor is all set.

4. Totestit, select MaterialsPurchase or ServiceContract in the Classes view by clicking on the yellowish-brown
icon next to either one and then go to that class's Instances view. (Y ou defined your constraint for the Purchases
class, but these subclasses will inherit it.)

5. Click the Instance view's Create instance icon 4 on the Instances view, assign the name pur chase105 to your
new purchase, and click the ok button. The postingDate value will automatically appear on your new purchase's
Resource Form, and you can then drag additional properties on the form and fill them out.

1.7 Adding constraints

A SPARQL Rules constraint defines a condition that, if true, should be brought to the user's attention. The SPARQL
ASK statement, which returns a boolean true or false value, isideal for this.

We're going to put a constraint on materials purchases so that TopSPIN alerts us to unpaid materials purchases that
are more than 90 days old.

1. Display the class form for the MaterialsPurchase class in the Classes view. Click the spin:constraint widget and
select Add empty row.

2. The default value has a skeleton for a SPARQL ASK statement; replace it with the following:

# an invoice with no paidDate is > 90 days old
ASK WHERE {
?this :invoiceDate ?invoiceDate .
OPTI ONAL {
?thi s purchases: pai dDat e ?pai dDate .

} .
FILTER ((!bound(?pai dDate)) && (snf:duration("d", ?invoiceDate, afn:now()) >
90)) .
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Thefirst lineisa SPARQL comment explaining what the constraint is checking for.

(l Remember to always add a comment at the beginning of a SPARQL query used to define a
. constraint. It will be used to alert the user to the problem when TopSPIN finds data that has violated
the constraint.

Finish entering the query by pressing Return or clicking Ok.

(l Instead of an ASK query, a SPARQL rule can use a CONSTRUCT query to create triples about the
. violated constraint. These triples can be used in applications built using the TopBraid platform. See
spinrdf.org for more information.

In our model, a paid invoice will have apai dDat e value and an unpaid one will not. If it doesn't (that is, if the ?
pai dDat e variableis not bound) and the ?i nvoi ceDat e is more than 90 days ago, we want the query aboveto
return aboolean value of "true". Likether andon() and par seDat e() functionswe saw earlier, thedur at i on()
function is from the SPARQL M otion namespace, which includes many other useful extension functions.

To test whether you've set up this constraint correctly, you want to have at least one purchase that is more than 90
days old and one that isn't. To do this,

1. Make surethat MaterialsPurchase is selected in the Classes view and open the Instances view.

2. Create another new MaterialsPurchase instance, and call this one pur chase106. Drag apur chases: dat e
property from the Properties view onto the pur chase106 form and enter date from about a month ago in mm/
dd/yy format. When you press Enter, you'll seei nvoi ceDat e get automatically updated with the new value.

3. Change the date you just entered to one from four months ago and press Enter.

4. Click the Display constraint violation warnings icon at the top of the screen & and you'll see smaller versions of the
same icon appear next to the headings for the form'si nvoi ceDat e and pai dDat e properties. You'll see another
version of the icon appear near the top of the form with a small white "1" on ared background to indicate that one
constraint violation has been found for this instance. (Clicking this repeatedly togglesit on and off.)

lo] X - o
Resource Form b = SEE T

UR!: |http:/ftopbraid.org/myPurchases#purchases 106

+ Annotations

« Other Properties

n
[3 2010-09-28 ~

pe Date —
LAd(2011-02-28T10:31: 34. 73-05:00 =
rdfitype —

purchases:MaterialsPurchase =

+ Incoming References

| Farm | Browser | Graph | Source Code
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5. For asummary of al the problems that TopBraid Composer can find in the current file, display the Problems view
(Window->Show View->Problems and click the Refresh all problems of current TopBraid file icon. "

6. To correct the error, select Add empty row from the pai dDat e widget, enter today's date in yyyy-mm-dd format
and press Enter. Even though the invoice date is more than 90 days ago, the invoice is marked as paid, so it'sno
longer a problem that needs flagging. At the top of the form, you'll see that the white"1" on ared squareis gone,
but a grayed-out version of the warning icon * remains to show you that TopBraid Composer has been set to
check for constraint violations; it just hasn't found any.

1.8 Defining and calling a template

Let'simplement a new business rule: we want to be alerted of unpaid service contract invoices that are more than 60
days old. Using the steps above, but substituting a 60" for a"90", thiswould all be quite straightforward, but as the
size of a system scales up, it's more maintainable if common code is shared and re-used instead of copied and pasted
from one place to another.

When using SPARQL Rules, you can create re-usable queries known as templates. These are flexible enough that you
can pass parameters to them to customize their behavior, so we're going to create a ChecklnvoiceAge template that
checks the age of an invoice and alerts the user if theinvoiceis older than the value passed as a parameter: 90 days
for materials purchases and 60 days for service contracts.

1. If you expand the spin:Modules nhode in the Classes view, you'll see that it has a subclass called
spi n: Tenpl at es. You could create a new template by right-clicking that and selecting " Create subclass', but
you can save some time and trouble by doing the following:

a. Select the purchases:MaterialsPurchase node in the Classes view.

b. Onitsclassform, click the triangle widget to the right of the spin:constraint that you've aready created (not the
similar widget above it) and select "Convert to SPIN template”.

- i spinisystemProperty

#an ce with no paidDate is = 20 days old - owl:versionInfo
ASK WHERE { T Sy p———

?this :invoiceDate ?invoiceDate . 3% Delete

T

?this :paidDate PpaidDate . "-.W STREATE R i
¥, = Execute as SPARGL Query
o (Inai WY 88 (e R
FILTER ({bound{?paidDate)} && {smf.duration{"d", Replace value with. .

finvoiceDate, afn:now() = 90)) .

This replaces the SPARQL query in the spin:constraint field with a call to the new template. The yellow
background shows that it's a call to another template, and the text shown in that field comes from the comment at
the beginning of the original constraint query.

2. Inthe Classes view, you'll see anew subclass of the spin:Templates class's spin:AskTemplates class with aname
obvioudly based on the comment in the original query: aninvoicewithnopaidDateis90daysold. Click its yellowish-
brown icon in the Classes view to display its details on the class form. On this form, change its name from
ani nvoi cewi t hnopai dDat ei s90daysol d to checkl nvoi ceAge.

3. To make this template more flexible, we need to replace the "90" with areference to an argument that gets
passed and then pass that argument from calls to the template in the definitions for the Material sPurchase and
ServiceContract classes.

The argument to the template is defined as a constraint on the template, so click the spin:constraint widget on the
checklnvoiceAge class form.
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4. Aswe did with the argument we defined to pass to the mmddyy2I SO8601 function, we'll use a built-in template
to define the argument, so pick "Create from SPIN template” and make sure that spl:Argument is selected in the
Available Ask/Construct Templates list.

5. Tofill out thisform, click the plus sign to the right of the predicate field and select sp:arg1 on the right of the
Select Resour ce dialog box and click the ok button.

(n Y ou can create your own argument names as well, which can improve readability.

6. To finish configuring the argument, on the Create from SPIN template dialog box:

« Replace the current content of rdfs:comment field with naxi num age of invoice in days and press
Enter.

e Click the plus sign next to the valueType field. On the Select Resour ce dialog box, click the Datatypes tab and
select xsd:int as the data type for the argument to be passed. (If you forget this step, the value will be passed as
astring, so when the template rule compares it with the numbers 60 or 90 we won't get the result we want.)

« Click ok toreturn to the class form for the checklnvoiceAge template.

7. Thespin:body value of thistemplateis already filled out for you, because you created it from an existing
constraint, but the FILTER condition is still hard coded to compare the number of days sincethei nvoi ceDat e
with the number 90. Replace "90" with ?argl, press Enter, and TopBraid Composer will bold this argument
reference in the SPARQL code.

ASK WHERE {
?this :invoiceDate PinvoiceDate |
OPTIONAL {
?this :paidDate paidDate .

FILTER {{Ibound{?paidDate}) && (smf:duration("d", PinvoiceDate, afn:now()) > ?argl)) .

8. Justasanrdfs: | abel property providesamore readable way to refer to a URI, the template rule's
spi n: | abel Tenpl at e property further down on the class form provides a more readable way to refer to the
template. It also provides away to pass an argument value into the template: replace 90 in the spin:labelTemplate
value with { ?ar g1} and press Enter.

9. We're done defining the template, and now it'stime to add callsto it in the constraint fields of the class formsfor
the Material sPurchase and ServiceContract classes. Go to the Material sPurchase form by clicking its yellowish-
brown icon in the Classes view and you'll see that its form already has a cal to to the template—it was created
when you told TopBraid Composer to create a template from the original constraint query that was there.

10. Instead of editing it, it will be ssimpler to just replaceit. Click the widget to the right of the yellow field and pick
Delete, and then pick Create from SPIN template from the spin:constraint widget.

11. Thistime, instead of picking a built-in template, you're going to pick the one that you just created:
checklnvoiceAge.

12. When you click it to select it, the Arguments part of the Create from SPIN template dialog box asksfor thear g1
value. Enter 90, press Enter, and click ok. You'll seethat the spi n: const r ai nt property has avalue of the
checklnvoiceAge's spin:labelTemplate value with "90" substituted for the "{ ?arg1}" part that you originally entered
there.
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sconstraint =

B¥-|an invoice with no paidDate is > 90 days old =7

13. Next, add a constraint to the ServiceContract class form that alerts the user to unpaid invoices that are more than
60 days old. Instead of defining a constraint, you'll create it from your new checkl nvoi ceAge template. The
steps will be almost identical to your addition of the similar constraint to the Material sPurchase class form.

Now, test your constraints. Select pur chases 106 from the pur chases: Mat eri al sPur chase classs
Instances view, click the white triangle next to the pur chases: pai dDat e property, and delete it. Change to
pur chases: dat e valueto recent and older dates and watch thei nvoi ceDat e values adjust and the constraint
violation warnings appear and disappear.

(l If you wanted to add the constraint that unpaid service contracts should be flagged when they were 60
. days old, you could use the same template, just passing it the different value asthe the ar g1 value.

1.9 Summing up

In thistutorial, you defined inferencing rules, constructors, and constraints around a set of data about a series of
purchases.

Remember, the SPARQL Rules property that you use to store your SPARQL query affects when that query is run,
and on which data:

« spin:rule When running inferences, apply the query in this property to each member of the classtheruleis
defined on and al subclass instances.

« gpin:constraint Define a constraint violation to be applied to all instances of a class, invoked by turning on
"Display constraint violation warnings' (the 4 icon).

* gpin:constructor Invoked on anew instance of a class when it's created.

If you click the spin:constructor and spin:rule widgets on any class form, you'll see that they also offer "Create from
SPIN template” as a choice. Templates can be called from many different places, and like the customized functions
that you can define, these are a valuable building block for creating applications.

Y ou defined al of these using SPARQL Inferencing Notation, an RDF vocabulary that adds a layer of new features
on top of SPARQL, but instead of writing out SPARQL Rules using RDF syntax (which is certainly possible) you
used TopBraid Composer as afront end to define the rules with a GUI interface that made it much easier to navigate
the model, data, and rules.

To actually see the effect of the rules—newly inferred triples, constraint violations, and more—you used
TopQuadrant's TopSPIN inferencing engine. As with the specification of the rules, you used Composer as afront end
to run TopSPIN and see its results, but you can take advantage of these same rules after creating them by using them
in applications developed with TopBraid Ensemble and SPARQLMotion and then deploy them for use by multiple
users with TopBraid Live.

These application development tools help you to build on your data and business rules to create customized user
interfaces for use by end users who may know nothing about RDF, triples, or SPARQL, but need to use the datain
the applications that you're designing for them. Before you even begin to develop and deploy user interfaces for these
applications, though, SPARQL Rules (SPIN) gives you extra capabilities in modeling your data and business rules
that can let the same set of data bring more value to multiple different applications.
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